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Birdville Independent School District 
 Elementary Technology Applications TEKS 

Scope and Sequence Skills Guide 
 

Our Mission, Goals, and Objectives 
 
BISD Mission: 
 
At Birdville Independent School District, our mission is to provide our elementary 
students with the technology skills necessary for becoming productive citizens in an 
increasingly technological world.  Subject area Texas Essential Knowledge 
and Skills (TEKS) will determine our purposeful use of the computer as a tool 
to enhance research, explore creativity, practice skills and communicate using 
text, sound and images, thus improving student achievement.  Students will learn 
how to gather, organize, and present information using the internet and 
educational software, as well as, universal tools such as Microsoft Word, Excel, 
PowerPoint, Kidspiration, Inspiration, and KidPix.  Students will also 
understand and apply the BISD Acceptable Use of the District’s Electronic 
Communications System Policy  located at the end of this document (click 
link to go to Acceptable Use Policy document). 
  
 
Technology application skills are a set of abilities which enables students to 
use electronic tools effectively and efficiently.  Acquisition of these skills enables 
students to make informed decisions about technologies and their applications.  
 
BISD Goals: 
 

 Enable students, teachers, and administrators of BISD to effectively integrate 
technology into the teaching and learning of the District. 

 Enhance learning through the use of digital content, since digital content 
changes the learning process thus allowing for greater levels of inquiry, 
analysis, interest, collaboration, creativity, content production, and student 
achievement. 
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 Integrate digital content when appropriate into content areas, or disciplines, 
so as to meet individual student learning needs outlined in the Texas 
Essential Knowledge and Skills, the BISD Graduate Profile and the BISD 
Goals and Objectives. 

 Ensure schools will have in the Campus Improvement Plan including a 
technology plan to integrate digital content and current hardware into teacher 
instruction and student learning.  

 
 
BISD Objectives: 
 

  The Instructional Technology Services staff, in collaboration with content 
area specialists, will establish Technology Applications Texas Essential 
Knowledge and Skills Literacy Guides for grades K-5. This project will 
address the need for all campus staff to have district guidelines that 
identify the technology skills that must be taught at each individual grade 
level as outlined in the State Technology TEKS. The TEKS for Grades K-5 
are very broad; therefore, this project will specify the skills and mastery by 
grade level. 

 The Literacy Guides will be posted on the Instructional Technology 
Services web site as well as referenced in the District’s Curriculum 
Management System. 

 Campus Staff will be made aware of the posting of the Technology 
Applications Literacy Guides and the District expectations for 
implementation by the Elementary Instructional Technology Team at 
campus Faculty and Grade Level meetings. 

 The Elementary ITS Team will provide ongoing integration technology 
support for campus administration, faculty, and students. 

 Technology TEKS Integrated Lessons will be posted on the Instructional 
Technology Website in a searchable database format.  These lessons will 
be correlated to the Texas Essential Knowledge and Skills curriculum, the 
BISD Goals and Objectives, and the BISD Profile of a Graduate goals and 
objectives. 

 The Elementary ITS Team will formally plan Technology integrated 
lessons and assemble appropriate student and teacher technology 
resources with and for K-5 grade level teams each six weeks period.  These 
lessons and resources will support the BISD Scope and Sequence 
curriculum. 

 Student and Teacher work will be evidence of implementation at each 
campus. 

 Student electronic portfolios will be created and used to evaluate student 
achievement. 

 Technology tools will be integrated into the classroom, not relegated to the 
lab setting only. 

 Student products will exhibit an emphasis on productivity tools revealing 
inquiry, analysis, interest, collaboration, and creativity. 
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 Student products will indicate that students have been taught the elements 
of information retrieval, including the ability to discern between primary 
and secondary resources, the difference between fact and opinion, and the 
ethics of using technology responsibly. 

 Distance Learning/Video Conferencing and the Internet will be used to 
engage students in higher order thinking and collaboration with others. 

 Teacher learning will be conducted incorporating consistent professional 
development aligned to State Board of Educator Certification (SBEC), No 
Child Left Behind (NCLB), and the Texas Long Range Plan for 
Technology expectations for educators. 
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Birdville Independent School District 
Grades PreK-2 Technology Applications 

Literacy Guide 
 

Upon Completion of Grade 2: 
 
 
Students are expected to: 
 
 

 Have a solid understanding of use and function of input devices 
as related to computer usage. 

 Have the ability to use a variety of technology resources to 
complete independent projects as assigned within the 
classroom. 

 Have the ability to effectively use technology terms and utilize 
those terms when discussing technology applications or 
projects. 

 Identify and use appropriate media and technology resources to 
enhance learning. 

 Demonstrate an understanding of Acceptable Use. 
 Demonstrate an understanding of computer etiquette. 
 Have the ability to work in cooperative groups to complete 
projects, utilizing technology and media resources to enhance 
the learning experience. 

 Use technology resources to solve problems and acquire 
information. 

 Use technology resources as a means to publish and 
communicate ideas. 

 Use technology to collect and distribute information. 
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Technology Applications TEKS 
Scope and Sequence 

Pre-Kindergarten/Kindergarten – Grade 2 
I=Introduced   A=Applied   M=Mastery 

 
 

Performance Descriptor PreK/K 1 2 
(1) Foundations: The student demonstrates knowledge and appropriate 
use of hardware components, software programs, and their 
connections. The student is expected 
 
(A) Uses technology terminology appropriate to task 
and grade level 

I I/A I/A 

(B) Start and exit programs as well as create, name, 
and save files  

I I/A A 

C) Use networking terminology such as on-line, 
network, or password and access 
remote equipment on a network such a printer 

I I A 

    
2) Foundations: The student uses data input skills appropriate to the 
task. The student is expected to 
 
(A) Use a variety of input devices such as mouse, 
keyboard, disk drive, modem, 
voice/sound recorder, scanner, digital video, CD-
ROM, digital camera or touch screen 

I A A 

(B) Use proper keyboarding techniques such as 
correct hand and body positions 
and smooth and rhythmic keystroke patterns as 
grade-level appropriate 

I A A 

C) Demonstrate touch keyboarding techniques for 
operating the alphabetic, 
numeric, punctuation, and symbol keys as grade-level 

I A A 
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appropriate 
 
(D) Produce documents at the keyboard, proofread, 
and correct errors 

I A A 

(E) Use language skills including capitalization, 
punctuation, spelling, word 
division, and use of numbers and symbols as grade-
level appropriate 

I A A 

    
3) Foundations. The student complies with the laws and examines the 
issues regarding the use of technology in society. The student is 
expected to: 
 
A) Follow acceptable use policies when using 
computers.  

I A A 

(B) Model respect of intellectual property by not 
illegally copying software or another individual's 
electronic work. 

I I/A A 

    
(4) Information acquisition. The student uses a variety of strategies to 
acquire information from electronic resources, with appropriate 
supervision. The student is expected to 
 
A) Apply keyword searches to acquire information; I I/A A 
B) Select appropriate strategies to navigate and access 
information for research and resource sharing 

I I/A A 

    
5) Information acquisition. The student acquires electronic information 
in a variety of formats, with appropriate supervision. The student is 
expected to: 
 
(A) Acquire information including text, audio, video, 
and graphics 

I I/A A 

(B) Use on-line help I I/A A 
    
(6) Information acquisition. The student evaluates the acquired 
electronic information.  The student is expected to: 
 
(A) Determine the success of strategies used to 
acquire electronic information 

I I/A A 

(B) Determine the usefulness and appropriateness of 
digital information. 

I I/A A 
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(7) Solving problems. The student uses appropriate computer-based 
productivity tools to create and modify solutions to problems. The 
student is expected to: 
 
(A) Use software programs with audio, video, and 
graphics to enhance learning 
experiences 

I A A 

(B) Use appropriate software, including the use of 
word processing and multimedia, to express ideas and 
solve problems. 

I A A 

    
(8) Solving problems. The student uses research skills and electronic 
communication, with appropriate supervision, to create new 
knowledge. The student is expected to: 
 
(A) Use communication tools to participate in group 
projects 

I A A 

(B) Use electronic tools and research skills to build a 
knowledge base regarding a topic, task, or 
assignment. 

I A A 

    
(9) Solving problems. The student uses technology applications to 
facilitate evaluation of work, both process and product. The student is 
expected to: 
 
(A) Use software features, such as on-line help, to 
evaluate work progress; 

I I/A A 

(B) Use software features, such as slide show 
previews, to evaluate final product. 

I A A 

    
(10) Communication. The student formats digital information for 
appropriate and effective communication. The student is expected to: 
 
(A) Use font attributes, color, white space, and 
graphics to ensure that products are 
appropriate for the defined audience; 

I A A 

(B) Use font attributes, color, white space, and 
graphics to ensure that products are 
appropriate for the communication media including 
multimedia screen displays 
and printed materials. 

I A A 
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(11) Communication. The student delivers the product electronically in 
a variety of media, with appropriate supervision. The student is 
expected to: 
 
(A) Publish information in a variety of media 
including, but not limited to, 
printed copy or monitor display; 

I A A 

(B) Publish information in a variety of media 
including, but not limited to, stored files or video. 

I A A 

    
(12) Communication. The student uses technology applications to 
facilitate evaluation of communication, both process and product. The 
student is expected to: 
 
(A) Select representative products to be collected and 
stored in an electronic 
evaluation tool; 

I A A 

(B) Evaluate the product for relevance to the 
assignment or task. 

I A A 
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Birdville Independent School District 
Grades 3-5 Technology Applications TEKS 

Literacy Guide 
 

Upon Completion of Grade 5: 
 
Students are expected to: 
 
 

 Utilize input and output devices at a mastery level. 
 Have the ability to discuss the use of technology as related to 
daily activities. 

 Have the ability to discuss issues related to responsible use of 
technology and describe the consequences for improper use. 

 Use productivity tools to support personal productivity and 
facilitate learning within the curriculum. 

 Use technology tools to create products for publication and 
display. 

 Have the ability to access information remotely and 
communicate with others to support independent learning. 

 Use technology resources for problem solving and extended 
learning activities. 

 Have the ability to select the appropriate productivity tools to 
express and idea or complete an electronic project. 

 Have the ability to determine usefulness of a technology 
resource as related to individual learning. 

 Have the ability to evaluate the accuracy, relevance and 
appropriateness of an electronic resource. 

 Have the ability to access a variety of media types to be used as 
resources to facilitate individualized learning. 
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Performance Descriptor 3 4 5 
(1) Foundations: The student demonstrates knowledge and appropriate 
use of hardware components, software programs, and their 
connections. The student is expected to: 
 
A) Uses technology terminology appropriate to task and 
grade level 

I/A I/A I/A 

B) Save and delete files, uses menu options and 
commands, and work with more than one software 
application; 

I I M 

(C) identify and describe the characteristics of digital 
input, processing, and output 

A A M 

(D) Delineate and make necessary adjustments regarding 
compatibility issues including, but not limited to, digital 
file formats and cross platform connectivity 

I A A 

E) Access remote equipment on a network such as a 
printer or other peripherals.  

I A M 

 
2) Foundations: The student uses data input skills appropriate to the 
task. The student is expected to: 
 
(A) Use a variety of input devices such as mouse, 
keyboard, disk drive, modem, voice/sound recorder, 
scanner, digital video, CD-ROM, digital camera or touch 
screen 

A A M 

Technology Applications TEKS 
Scope and Sequence 
Grade 3 – Grade 5 

I=Introduced    A=Applied    M=Mastery 
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(B) Use proper keyboarding techniques such as correct 
hand and body positions and smooth and rhythmic 
keystroke patterns as grade-level appropriate 

A A M 

C) Demonstrate touch keyboarding techniques for 
operating the alphabetic, 
numeric, punctuation, and symbol keys as grade-level 
appropriate 

A A M 

(D) Produce documents at the keyboard, proofread, and 
correct errors 

A A M 

(E) Use language skills including capitalization, 
punctuation, spelling, word 
division, and use of numbers and symbols as grade-level 
appropriate 

A A M 

(F) Demonstrate an appropriate speed on short timed 
exercises depending upon the grade level and hours of 
instruction. 

I A M 

 
3) Foundations. The student complies with the laws and examines the 
issues regarding the use of technology in society. The student is 
expected to: 
A) Follow acceptable use policies when using computers.  A A M 
(B) Model respect of intellectual property by not illegally 
copying software or another individual's electronic work. 

A A M 

 
(4) Information acquisition. The student uses a variety of strategies to 
acquire 
information from electronic resources, with appropriate supervision. 
The student is expected to: 
A) Apply appropriate electronic search strategies in the 
acquisition of information including keyword and Boolean 
search strategies; 

A A M 

(B) Select appropriate strategies to navigate and access 
information on local area networks (LANs) and wide area 
networks (WANs), including the Internet and intranet, for 
research and resource sharing. 

I A A 

 
5) Information acquisition. The student acquires electronic information 
in a variety 
of formats, with appropriate supervision. The student is expected to: 
(A) Acquire information including text, audio, video, and 
graphics 

A A M 

(B) Use on-line help and documentation A A M 
 
(6) Information acquisition. The student evaluates the acquired 
electronic information. 
The student is expected to: 
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(A) Apply critical analysis to resolve information conflicts 
and validate information; 

I A A 

(B) Determine the success of strategies used to acquire 
electronic Information; 

A A M 

(C) Determine the usefulness and appropriateness of 
digital information. 

A A M 

 
(7) Solving problems. The student uses appropriate computer-based 
productivity tools to create and modify solutions to problems. The 
student is expected to: 
(A) Use software programs with audio, video, and 
graphics to enhance learning 
experiences 

A A M 

(B) Use appropriate software to express ideas and solve 
problems including the use of word processing, graphics, 
databases, spreadsheets, simulations, and multimedia; 

A A M 

(C) Use a variety of data types including text, graphics, 
digital audio, and video 

I A A 

 
(8) Solving problems. The student uses research skills and electronic 
communication, with appropriate supervision, to create new 
knowledge. The student is expected to: 
(A) Use communication tools to participate in group 
projects 

A A M 

(B) Use interactive technology environments, such as 
simulations, electronic science or 
mathematics laboratories, virtual museum field trips, or 
on-line interactive lessons, to manipulate information 

A A M 

(C) Participate with electronic communities as a learner, 
initiator, contributor, or mentor 

I A A 

 
(9) Solving problems. The student uses technology applications to 
facilitate evaluation of work, both process and product. The student is 
expected to: 
(A) Use software features, such as on-line help, to evaluate 
work progress; 

A A M 

(B) Use software features, such as slide show previews, to 
evaluate final product 
. 

A A M 

 
(10) Communication. The student formats digital information for 
appropriate and effective communication. The student is expected to: 
(A) Use font attributes, color, white space, and graphics to 
ensure that products are appropriate for the defined 
audience; 

A A M 

(B) Use font attributes, color, white space, and graphics to A A M 
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ensure that products are appropriate for the 
communication media including multimedia screen 
displays, Internet documents, and printed materials. 
(c ) Use appropriate applications including, but not 
limited to, spreadsheets and databases to develop charts 
and graphs by suing data from various sources. 

I A A 

 
(11) Communication. The student delivers the product electronically in 
a variety of media, with appropriate supervision. The student is 
expected to: 
(A) Publish information in a variety of media including, 
but not limited to, printed copy,  monitor display, Internet 
documents, and video 

A A M 

(B) Use presentation software to communicate with 
specific audiences. 

A A M 

 
(12) Communication. The student uses technology applications to 
facilitate evaluation of communication, both process and product. The 
student is expected to: 
(A) Select representative products to be collected and 
stored in an electronic evaluation tool; 

A A M 

(B) Evaluate the product for relevance to the assignment 
or task. 

A A M 

(C) Create technology assessment tools to monitor 
progress of project such as a checklist, timeless, or rubrics 

I A M 
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Elementary Technology Applications TEKS 

Literacy Guide 
Kindergarten 

 
 

Vocabulary:  Learn grade level appropriate technology 
terminology. 1A 
 
Mouse Mouse pad Monitor 
Keyboard Computer Printer 
Desktop Cursor Click 
Double-click Network folder Username 
Password Log on/Log off CD-ROM/CD-ROM 

Drive 
Save/Save As Print Click-and-Drag 
Network Portfolio Internet 

 

Skills/Foundations: 
 
Use My Computer to navigate to available drives.  2C 
Open programs by using the mouse to single click/Enter or double click program 
icons (shortcuts) on the desktop.   1B  
Exit Programs by clicking on the “X” in the upper right hand corner of a program 
window.  1B 
Use mouse to perform single-click, double-click, and click and drag functions 
with the left mouse button only.  2A 
Use the mouse to scroll up or down within a window by clicking the up or down 
arrows.  2A 
Navigate through an appropriate program.  2A 
Print a document.  1C 
Use draw tools through Microsoft Paint or KidPix.  7A 
Create, name, and save files.  1BM 
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Networking: 

 
Log on to the BISD network using personal username by the end of the first 
semester.  1C 
Log off network.  1C 
Create, name, and save files to personal drive on the network.   1B 
Access files from the network folder drive.  1C 
Print to a networked printer using the printer icon.  1C 

 

Acceptable Use: 

 
Knows not to use other’s work  3A, 3B  
Knows it is inappropriate to access another individual’s file. 3B 
Teachers will explain the rules included in the BISD Acceptable Use Policy and 
model appropriate use of the computer.  
Student will demonstrate an understanding of the rules when accessing BISD 
computers.  3A 

 
 

Information Acquisition: 

 
With teacher assistance, acquire information that is in the form of text, graphics, 
audio, and video.  5A 

 

Problem Solving: 

 
Use software to express ideas and solve problems.   
This can include, but is not limited to text, graphics, charts, multimedia, and 
visual organizers.  7A, 7B 
Use communication tools to acquire and share information and solve problems 
(e.g. distance learning).  8A 

 

Software Applications: 
 
Word Processing (Microsoft Word): 
 
Create a new document or open an existing one.  1B, 2D 
Enter text.  2D 
Change font size.  10A 
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Use the Backspace key to delete text.  2D 
Use the Shift key to make capital letters.  2D 
 
Multimedia (PowerPoint): 
 
Open an existing presentation from the network folder.  7A, &B 
Use a teacher-created template to complete an activity.  7A, 7B 
Add text to slides.  11A, 11B 
 
Paint (KidPix) 
Open a new picture or an existing picture.  7A 
Use paint tools and background textures.  7A 
Use the picture stamps for illustrations.  7A 
Use the letter stamps to create words.  7A 
Use the text box tool to write words or sentences.  7A 
Use the eraser tool to delete painted text or illustrations.  7A 
Use the dynamite tool to clear work area.  7A 
Use the undo tool to undo the last action.  7A 
 
Graphic Organizer (Kidspiration/Inspiration): 
 
Open a teacher-created template and complete an activity.  7A 
Open a Kidspiration or Inspiration template to complete an activity.  7A, 11A 
 
Internet Browser (Internet Explorer): 
 
Click on a link to view a web site.  8B 
Use the Back, Forward, and Home buttons to navigate.  8B 

 
 
 

Communication: 

 
Use desktop publishing techniques to create effective documents and 
presentations (begin to make good choices with regard to font, white space, and 
contrast).  10A, 10B, 11A, 11B 
Display work for a variety of audiences in a variety of forms (print, monitor, 
projector, and video).  11A, 11B 
Select representative products to be collected and stored in an electronic portfolio 
with teacher assistance.   12A 
Begin to evaluate products created.  12B 
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PreK/Kindergarten Technology Terminology 
 

Mouse 

A device that controls the pointer on the 
screen.  

Mouse pad 

Pad on which a mouse operates.  
Monitor 

A display screen designed as an output 
device for a computer. 

Keyboard 
An input device with keys that has 

letters, numbers, or symbols used to enter 
information into a computer. 

Computer 

An electronic machine that can perform 
calculations and can process a large amount of 
information accurately and much more rapidly 

that the human brain. 
Printer 

A mechanical output device that can print 
text and graphics on paper. 

Desktop 

The area on the screen where you move 
windows and icons around. 

Cursor     l           A highlighted or bright ( sometimes 
blinking) line or other mark that shows were 

information is being input; that is, where the next 
letter or character will appear.   

Click 

To press and release a button one time 
on the mouse. 
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Double-click 

The process of pressing the mouse 
button two times in rapid succession. Double-
clicking is usually used to launch a program or 

open a file.   
Network folder Virtual drive in which a computer is connected.  

Information, programs, and files can be stored 
and retrieved here. 

Username The unique name provided to each user who has 
an account on the network.  Sometimes referred 

to as a login name.  
Password *****   A secret series of characters that enables 

a user to access a file, computer, or program.  
Log on Connecting with a computer network system, 

usually requiring the use of a username or 
password.  

Log off Exiting programs and disconnecting from the 
computer network system.  

Save 

To store a file on diskette, hard drive, 
CD, or network folder for future use.  

Save As 

Stores a file on a diskette, hard drive, CD, 
or network folder, and allows the user to name 

the file.  
Print 

To produce a paper copy of information 
displayed on a monitor.  A user can also print 

files, faxes, and screens. 
Click-and-drag A four-step process that moves an object across 

the screen and “drops” it into a new location.  
Network 

The entire collection of computers 
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connected to a server with patch 
(network/internet) cables.  The network allows 
users to share information from one networked 

computer to another.  
Portfolio A collection of a student’s work.  
Internet 

The Internet is an international 
collection of interconnected, independent 

networks that support a common set of data 
communication protocols.  The Internet provides 

connectivity and several applications such as 
email.  

CD-ROM  

 (Compact Disk Read Only Memory) 
CD-ROM readers can be attached to a computer 

and make available to it the large amounts of 
digitally encoded information stored on the round 

CR-ROM disks.  
CD-ROM drive  

The drive that allows data to be recorded 
and read from CD’s.  
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*Shading indicates new skills for this grade level. 
 
 

Elementary Technology Applications TEKS 
Literacy Guide 

Grade One  
 

Vocabulary:  Learn grade level appropriate technology 
terminology. 1A 

 
New:    
Icon Email My Computer 
Delete On-line Webpage 
Menu CPU Folder 
Disk/Disk drive Program Taskbar 
File Shortcut Server 
   
   
Review:   
Mouse Mouse pad Monitor 
Keyboard Computer Printer 
Desktop Cursor Click 
Double-click Network folder Username 
Password Log on/Log off CD-ROM/CD-ROM 

drive 
Save/Save As Print Click-and-Drag 
Network Portfolio Internet 

 

Skills/Foundations: 
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Use My Computer to navigate to available drives.   2C 
Open programs by using the mouse to single click/Enter; double click program 
icons (shortcuts) on the desktop, and from Start, Programs and choosing 
appropriate programs.  1B 
Exit Programs by clicking on the “X” in the upper right hand corner of a program 
window and by going clicking File and clicking Exit.   1B 
Use mouse to perform single-click, double-click, and click and drag functions 
with the left mouse button only.  2A 
Use the mouse to scroll up or down within a window by clicking and dragging the 
scroll bar or clicking the up or down arrows.  2A 
Minimize windows (shrink to Taskbar) by clicking the underscore in the top 
right corner of any window. 2A 
Click the minimized file in the taskbar to display the window. 2A 
Open CD-ROM tray, insert CD, close CD-ROM tray, and access files/programs on 
CD.  2A 
Use Save and Save As appropriately.   Save As- Allows the destination, file 
name, and file type to be chosen.  Save- Saves files using existing location, file 
name, and file type.   1B 
Use the Undo feature in Microsoft Office applications to recover previous work  
(i.e. recover typed words , unpaste, unformat, etc.)  2D 
Print documents.  1C 
Use the laptops within the wireless lab (COWS).   2A 
Navigate through appropriate programs.  2A 
Use draw tools through Microsoft Paint or KidPix.  7A 

 

Networking: 

 
Log on to the BISD network using personal username by the end of the second six 
weeks.  1C 
Log off network.  1C 
Create, name, and save files to personal drive on the network.  1B 
Access files from the network folder.  1C 
Print to a networked printer using the printer icon or selecting Print from the 
File menu.  1C 
Save files from the network folder by copying (by clicking and dragging the icon).  
Example:  Students drag and drop to their desktop a copy of a teacher-made 
template that they will complete.    1B, 1C 

 

Acceptable Use: 

 
Knows not to use other’s work  3A, 3B 
Knows it is inappropriate to access another individual’s file. 3B 
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Teachers will explain the rules included in the BISD Acceptable Use Policy and 
model appropriate use of the computer.  
Student will demonstrate an understanding of the rules when accessing BISD 
computers.  3A 

 
 

 
 
 
 

Problem Solving: 

 
Use software to express ideas and solve problems.   
This can include, but is not limited to text, graphics, charts, multimedia, visual 
organizers, and spreadsheets. 7A, 7B 
Use preview options (e.g. Print Preview, Slideshow/View Show in 
Microsoft PowerPoint) to evaluate the results of work before final product is 
presented.  9B 
Use communication tools to acquire and share information and solve problems 
(e.g. distance learning, email).  8A 

 

Software Applications: 
 
 
Word Processing (Microsoft Word): 
 
Create a new document or open an existing one.  1B, 2D, 7B 
Enter text.  2D 
Change font size and type of font.  10A 
Use the Backspace key to delete text.  2D 
Use the Shift key to make capital letters and access punctuation marks.  2D 
Insert clipart from Clipart Gallery.   10A 
 
Multimedia (PowerPoint): 
 
Open an existing presentation from the network folder.  7A, 7B 

Information Acquisition: 

 
With teacher assistance, acquire information that is in the form of text, graphics, 
audio, multimedia, and video and save information for use in student projects 
consistent with copyright issues.  5A, 5B, 8A 
Analyze the content (“Is it what I need?”) obtained from the Internet.  6A, 6B 
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Use a teacher-created template to complete an activity.  7A, 7B 
Change font size and type.  10A, 10B 
Insert Clipart.  10A, 10B 
Add text to slides.  11A, 11B 
 
Spreadsheet (Excel): 
 
Open an existing spreadsheet on the network folder.   7A, 7B 
Enter data in an existing template to complete an activity (e.g. have a spreadsheet 
set up so that students can enter data into the spreadsheet and a graph/chart will 
automatically be created with the results).  7B 
 
Paint (KidPix): 
 
Open a new picture or an existing picture. 7A 
Use paint tools and background textures.  7A 
Use the picture stamps for illustrations.  7A 
Change the size of picture stamp.  7A  
Use the letter stamps to create words.  7A 
Use the text box tool to write words or sentences. 
Use the eraser tool to delete painted text or illustrations.  7A 
Use the dynamite tool to clear work area.  7A 
Use the undo tool to undo the last action.  7A 
 
Graphic Organizer (Kidspiration/Inspiration): 
 
Open a Kidspiration/Inspiration template or a teacher-created template to 
complete an activity. 7A, 11A 
Insert symbols or pictures into a diagram.  7B 
Insert text. 7B 
Change the font size and type.  10A 
 
Internet Browser (Internet Explorer): 
 
Click on a link to view a web site.  8B 
Use the Back, Forward, and Home buttons to navigate.  8B 

 
 
 

Communication: 

 
Use desktop publishing techniques to create effective documents and 
presentations (continue to learn to make good choices with regard to font, white 
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space, and contrast).  10A, 10B, 11A, 11B 
Display work for a variety of audiences in a variety of forms (print, monitor, 
projector, and video).  11A, 11B 
Select representative products to be collected and stored in an electronic portfolio 
with teacher assistance. 12A 
Continue to evaluate products created for relevance to the assignment or task. 12B 
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1st Grade Technology Terminology 
 
 

Icon 
 A small image on the desktop that 

represents a program, file, or document.  
Email 

(Electronic mail): Sending messages 
from one computer to another.  

Delete Erases information, text and images, from a 
document.  

Menu 

 A list of options from which to 
choose.  

CPU 

The CPU (Central 
Processing Unit) is the “brains” of the 
computer. It is also known as the 
processor.  

Webpage 

 A file and associated files that 
appear in a web browser at one time.  
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My Computer 

 A list of all the drives, 
network connections, and control panel items in 

your computer.  
Disk 

The most common storage device used 
with computers.   

Disk Drive A part of the computer that operates the 
disks that store information. 

Program A software program that allows you to do 
different things on the computer.  Microsoft 

Office, KidPix, Inspiration, etc.  
Folder  An area for storing files to keep them 

organized.  Folders can be placed within other 
folders to assist with further organization. 

File 
A collection of data or 

information that has a name.  
Shortcut 

 An icon that points to a program on the 
computer.   

Taskbar  
The bar that is located at the bottom of the screen 
that lists all currently running programs and open 

folders.  
Server 

A server is usually a computer that 
provides the information, files, Web pages, and 

other services to the client that logs on to it. 

mydog.doc 
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*Shading indicates new skills for this grade level. 
 
 

Elementary Technology Applications TEKS 
Literacy Guide 

Grade Two 
 

Vocabulary:  Learn grade level appropriate technology 
terminology. 1A 

 
New:    
Hard drive (c:) Floppy drive (a:)  Hardware 
Software Paste Cable 
Window Browser Font 
Text Toolbar Word processing 
Document Edit Cut 
Copy   
   
Review:   
Icon Email My Computer 
Delete On-line Server 
Menu CPU Webpage 
Disk/Disk drive Program Folder 
File Shortcut Taskbar 

 

Skills/Foundations: 
 
Use My Computer to navigate to available drives. 2C 
Open and close programs using method of choice.  1B 
Use mouse to perform single-click, double-click, and click and drag functions 
with the left mouse button only.  2A 
Use the mouse to scroll up or down within a window by clicking and dragging the 
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scroll bar or clicking the up or down arrows.  2A 
Minimize windows (shrink to Taskbar) by clicking the underscore in the top 
right corner of any window.  2A 
Click the minimized file in the taskbar to display the window.  2A 
Maximize or restore an opened window by clicking on the middle button in the 
upper-right corner of any window. 2A 
Open CD-ROM tray, insert CD, close CD-ROM tray, and access files/programs on 
CD. 2A 
Use Save and Save As appropriately. Save As- Allows the destination, file 
name, and file type to be chosen.  Save- Saves files using existing location, file 
name, and file type.  1B 
Use the Undo feature in Microsoft Office applications to recover previous work 
(i.e. recover typed words, unpaste, unformat, etc.) 2D 
Take pictures using the digital camera.  2A 
Print documents.  1C 
Use the laptops within the wireless lab (COWS) and begin to use the touchpad as 
a mouse.   2A 
Navigate through appropriate programs.  2A 
Use Copy, Cut, and Paste functions to edit documents.  2D 

 

Networking: 

 
Log on to the BISD network using personal username by the end of the first six 
weeks.  1C 
Log off network.  1C 
Create, name, and save files to personal drive on the network.  1C 
Access files from the network folder.  1C 
Print to a networked printer using the printer icon or selecting Print from the 
File menu.  1C 
Save files from the network folder by copying (by clicking and dragging the icon) 
or using the Save As feature within the program.   1B, 1C 

 

Acceptable Use: 

 
Knows not to use other’s work. 3A, 3B 
Knows it is inappropriate to access another individual’s file.  3B 
Student will demonstrate an understanding of the rules when accessing BISD 
computers.  3A 
Teachers will reinforce rules included in the BISD Acceptable Use Policy and 
model appropriate use of the computer. 3A 
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Problem Solving: 

 
Use software to express ideas and solve problems.   
This can include, but is not limited to text, graphics, charts, visual organizers, 
multimedia and spreadsheets.  7A, 7B 
Use preview options (e.g. Print Preview, Slideshow/View Show in Microsoft 
PowerPoint) to evaluate the results of work before final product is presented. 9B 
5B 
Use communication tools to acquire and share information and solve problems 
(e.g. distance learning, email)  8A 

 

Software Applications: 
 
Word Processing (Microsoft Word): 
 
Create a new document or open an existing one on the network folder.  1B, 2D, 7B 
Enter text.  2D 
Change font size, type, style (bold, italicize, underline), and color of font.  
10A 
Use the Backspace and Delete key to delete text. 2D 
Use the Shift key to make capital letters and access punctuation marks. 2D 
Insert pictures from Clipart Gallery and from File (e.g. My Pictures, network 
folder, digital camera, scanner, or other source).  2A,  10A 
 
Multimedia (PowerPoint): 
 
Open an existing presentation from the network folder.  7A, 7B 
Use a teacher-created template to complete an activity.  7A, 7B 
Create a new presentation.  7B 
Insert at least 2 new slides.  7B 
Change font size, type, style (bold, italicize, underline), and color.  10A 
Insert pictures from Clipart Gallery and from File (e.g. My Pictures, network 

Information Acquisition: 

 
With teacher assistance, acquire information that is in the form of text, graphics, 
audio, and video and save information for use in student projects consistent with 
copyright issues.  5A, 5B, 8B 
Analyze the content (“Is it what I need?”) obtained from the Internet.  6A, 6B 
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folder, digital camera, scanner, or other source).  2A, 10A 
Add text to slides.  11A, 11B 
Use the Slide Sorter view to organize (change sequence) and edit presentation.  
9a, 9B 
 
Spreadsheet (Excel): 
 
Open and existing spreadsheet on the network folder. 7A, 7B 
Enter data in an existing template to complete an activity (e.g. have a spreadsheet 
set up so that students can enter data into the spreadsheet and a graph/chart will 
automatically be created with the results). 7B 
 
Desktop Publishing (Microsoft Publisher): 
 
Use a teacher-created template to complete an activity.  7B 
Click in the text boxes and replace text.  2D 
 
Paint (KidPix): 
 
Open a new picture or an existing picture. 7A 
Use paint tools and background textures. 7A 
Use the picture stamps for illustrations. 7A 
Change the size of picture stamp. 7A 
Use the letter stamps to create words. 7A 
Use the text box tool to write words or sentences. 7A 
Use the eraser tool to delete painted text or illustrations. 7A 
Use the dynamite tool to clear work area. 7A 
Use the undo tool to undo the last action. 7A 
Create a slide show.  7A, 7B, 11A 
 
Graphic Organizer (Kidspiration/Inspiration): 
 
Open a Kidspiration/Inspiration template or a teacher-created template to 
complete an activity. 7A, 11A 
Insert symbols or pictures into a diagram.  7B 
Insert text. 7B 
Change the font size, type, style (bold, italicize, underline), and color. 10A 
Use the Rapid Fire (Inspiration) tool to input ideas into a diagram.  8B 
 
Internet Browser (Internet Explorer): 
 
Click on a link to view a web site. 8B 
Use the Back, Forward, and Home buttons to navigate. 8B 
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Conduct simple keyword searches using a grade-level appropriate/kid friendly 
search engine, such as Yahooligans.   4A, 4B, 8B 
Gather information from the websites found from search results.  5A, 8B 
Evaluate the effectiveness of search strategies.  6A   
Determine whether web sites provide useful and appropriate information. 6B 

 
 

Communication: 
 
Display work for a variety of audiences in a variety of forms (print, monitor, 
projector, and video).  11A, 11B 
Use desktop publishing techniques to create effective documents and 
presentations (make good choices with regard to font, white space, and contrast 
for readability).  10A, 10B, 11A, 11B 
Proofread products and make improvements.  2D, 2E 
Select representative products to be collected and stored in an electronic portfolio 
with teacher assistance.  12A 
Evaluate products created for relevance to the assignment or task.  12A 
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2nd Grade Technology Terminology 
 

Hard drive 
(c:)  

The large storage area on your 
computer in which documents, files, programs, and 
data are stored. The hard drive is usually assigned 

the drive letter of C and is often several gigabytes in 
size.  

Floppy drive 
(a:) 

The unit into which a floppy disk is inserted 
to be read or written by the computer.  

Cable A cable is a long, rubber-coated bundle 
of wires, with plugs on either end, which 
connects computer parts.  

   

Window 

A rectangle on the screen that 
displays information.  A window can contain small 

images (icons), a document, or an application.  
Browser 

Software used to access the World Wide Web 
(Internet) to view text, as well as a variety of other 

media types.  
Font 

A set of characters with a particular 
design and size.  
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Toolbar A row or column of on-
screen buttons used to activate functions in the 

application. Some toolbars are customizable, letting 
you add and delete buttons as required. 

Hardware 

The parts of a computer system 
that you can touch. Examples of 
hardware are input devices like 
keyboards and mice, and output devices 
such as printers and monitors. 

Software 

Software is the programs that 
run on a computer.  

Word 
processing 

Software that can be used to produce 
documents, including letters, reports, stories, etc. 

Document 

A word processing file.  
Text  Letters within a document.  
Edit To make corrections and revisions.  
Copy To make an exact duplicate of information in a 

document so it can be placed in a new location. 
Cut Deletion of text or graphics that is subsequently 

copied and can be placed in a new location.  
Paste To place text or graphics in a new location.  
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*Shading indicates new skills for this grade level. 
 

 

Elementary Technology Applications TEKS 
Literacy Guide 
Grade Three 

 
Vocabulary:  Learn grade level appropriate technology 
terminology. 1A 

 
New:    
Format Style Program/applicati

on 
File/document Scanner Digital format 
Spreadsheet Hyperlink Word processor 
Taskbar Database Search engine 
   
Review:   
Hard drive (c:) Floppy drive (a)  Hardware 
Software Paste Cable 
Window Browser Font 
Text Toolbar Word processing 
Document Edit Cut 
Copy   
   

 

Skills/Foundations: 
 
Use My Computer to navigate to available drives. 2C 
Open and close programs using method of choice. 1B 
Use mouse to perform single-click, double-click, and click and drag functions 
with the left and right mouse buttons.  2A 
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Use the mouse to scroll up or down within a window by clicking and dragging the 
scroll bar or clicking the up or down arrows.  2A 
Minimize, maximize, and restore windows as needed.  2A 
Open CD-ROM tray, insert CD, close CD-ROM tray, and access files/programs on 
CD.  2A 
Understand and properly use Save and Save As appropriately. Save As- Allows 
the destination, file name, and file type to be chosen. Save- Saves files using 
existing location, file name, and file type.  1B 
Use the Undo feature in Microsoft Office applications to recover previous work 
(i.e. recover typed words, unpaste, unformat, etc.) 2D 
Take pictures using a digital camera and upload them to a computer.  2A 
Print documents. 1E 
Use the scanner to digitize images and use them within an application. 2A, 7C 
Use the laptops within the wireless lab (COWS) applying skills learned to use the 
touchpad as a mouse.  2A 
Navigate through appropriate programs. 2A 
Use Copy, Cut, and Paste functions to edit documents. 2D, 7B, 7C 
Use the Help menu to type in a keyword and/or look at the available list of 
topics. 9A 
Use the Print Preview, Slideshow/View Show, and Slide Sorter View 
features available in programs to view files for proper format prior to printing. 9B 

 

Networking: 

 
Log on to the BISD network using personal username by the end of the first six 
weeks.  1E 
Log off network. 1E 
Create, name, and save files to personal drive on the network. 1B 
Access files from the network folder. 1E 
Print to a networked printer using the printer icon or selecting Print from the 
File menu. 1E 
Select and print to the appropriate networked printer. 1E 
Save files from the network folder by copying (by clicking and dragging the icon) 
or using the Save As feature within the program.  1B 

 

Acceptable Use: 

 
Knows not to use other’s work. 3B 
Knows it is inappropriate to access another individual’s file. 3B 
Knows it is not appropriate to copy/load software for which you do not have a 
license.  3B 
Student will demonstrate an understanding of the rules when accessing BISD 
computers.  3A 
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Teachers will reinforce the rules included in the BISD Acceptable Use Policy and 
model appropriate use of the computer.  3A 

 
 

 
 
 
 

Problem Solving: 

 
Use software to express ideas and solve problems.   
This can include, but is not limited to text, graphics, charts, and visual organizers, 
multimedia and spreadsheets. 7A, 7B, 7C, 10C 
Use communication tools to acquire and share information and solve problems 
(e.g. distance learning, email).  8A, 8B, 8C 

 

Software Applications: 
 
Word Processing (Microsoft Word): 
 
Create a new document or open an existing one on the network folder. 2D, 2E 
Enter text. 2C, 2D 
Change font size, type, style (bold, italicize, underline), and color of font. 
10A, 10B 
Use Alignment tools to format text (left, right, center, justify).  10A, 10B 
Format text by using Bullets and Numbering.  10A, 10B 
Use the Backspace and Delete key to delete text.  2D 
Use the Shift key to make capital letters and access punctuation marks. 2C, 2D 
Insert pictures from Clipart Gallery and from File (e.g. My Pictures, network 
folder, digital camera, scanner, or other source).  2A, 10A 
Move and resize clipart and or images by right-clicking on the image, selecting 
Format Picture, clicking the Layout tab, and choosing the appropriate 
Wrapping Style or using the Picture Toolbar.  7A, 10A 
 
Multimedia (PowerPoint): 

Information Acquisition: 

 
Acquire information that is in the form of text, graphics, audio, and video and 
save information for use in student projects consistent with copyright issues, with 
teacher assistance, as needed. 5A, 4A, 4B 
Analyze the content (“Is it what I need?”) and validate the quality (“Is the 
information accurate?”) of information obtained from the Internet. 6A, 6B, 6C 
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Create a new presentation or open an existing presentation on the network 
folder.  7A, 7B, 1E 
Use a teacher-created template to complete an activity. 7A, 7B 
Add text to slides.  11A, 11B 
Insert multiple New Slides.  7A, 7B 
Change font size, type, style (bold, italicize, underline), and color. 10A, 10B 
Use Alignment tools to format text (left, right, center, justify).  10A, 10B 
Format text by using Bullets and Numbering.  10A, 10B 
Insert pictures from Clipart Gallery and from File (e.g. My Pictures, network 
folder, digital camera, scanner, or other source).  2A, 10A 
Change backgrounds by selecting Format from the menu bar and choosing 
Background. 10A, 10B 
Use the Slide Sorter view to organize (change sequence) and edit presentation. 
9A, 9B 
 
Spreadsheet (Excel): 
 
Open and existing spreadsheet on the network folder.  1E, 10C 
Enter data in an existing template to complete an activity (e.g. have a spreadsheet 
set up so that students can enter data into the spreadsheet and a graph/chart will 
automatically be created with the results). 7B, 10C 
Identify and locate cells, rows, and columns. 7B, 7C 
Create a spreadsheet by entering text, and values (numeric).  7B, 10C 
Use Chart Wizard to create charts/graphs as grade level and task appropriate 
to express ideas and solve problems. 7B, 10C 
Change the font size, type, style (bold, italicize, underline), and color.  10A, 
10B 
 
Desktop Publishing (Publisher): 
 
Use a teacher-created template to complete an activity.  1E, 7A, 7C 
Click in the text boxes and replace text.  2D 
Insert pictures from Clipart Gallery and from File (e.g. My Pictures, network 
folder, digital camera, scanner, or other source).  2A, 10A 
 
Paint (KidPix): 
 
Open a new picture or an existing picture. 7A 
Use paint tools and background textures. 7A 
Use the picture stamps for illustrations. 7A 
Change the size of picture stamp. 7A 
Use the letter stamps to create words. 7A 
Use the text box tool to write words or sentences. 7A 
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Use the eraser tool to delete painted text or illustrations. 7A 
Use the dynamite tool to clear work area. 7A 
Use the undo tool to undo the last action. 7A 
Create a slide show. 7A 
 
Graphic Organizer (Kidspiration/Inspiration): 
 
Open a Kidspiration/Inspiration template or a teacher-created template to 
complete an activity. 7A, 11A 
Insert symbols or pictures into a diagram.  7C 
Insert text. 7C 
Change the font size, type, style (bold, italicize, underline), and color. 10A, 
10B 
Use the link tool to connect objects within a diagram. 7A 
Compile notes and ideas into outlines using the outline view and diagram view 
(Inspiration).7A, 7C 
Use the Rapid Fire tool (Inspiration) to input ideas into a diagram. 7A, 7B, 7C 
 
Internet Browser (Internet Explorer): 
 
Click on a link to view a web site. 5A 
Use the Back, Forward, and Home buttons to navigate. 5A, 5B 
Conduct simple keyword searches using a grade-level appropriate/kid friendly 
search engine, such as Yahooligans. 4A, 4B, 5A 
Gather information from the websites found from search results. 5A, 5B 
Evaluate the effectiveness of search strategies. 6A, 6B 
Determine whether web sites provide useful and appropriate information. 6C 
Use the acquired information in the creation of products. 11A 
Use the web to tour virtual environments, remote locations, and/or explore on 
line interactive lessons. 8B 

 
 
 

Communication: 

 
Display work for a variety of audiences in a variety of forms (print, monitor, 
projector, and video).  10B 
Use desktop publishing techniques to create effective documents and 
presentations (make good choices with regard to font, white space, and contrast 
for readability).  10A 
Create charts/graphs using spreadsheets/databases and extract information from 
them.  10C 
Proofread products and make improvements. 2D, 2E 
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Use tools such as checklists, timelines, and rubrics to evaluate products and 
determine relevancy to task and specific lesson objectives. 12B 
Select representative products to be collected and stored in an electronic portfolio 
with teacher assistance. 12A 
Evaluate products created for relevance to the assignment or task.  12A 
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3rd Grade Technology Terminology 
 

Format 

Format is the structure, or 
layout, of an item. 

Screen formats are the layout of fields 
on the screen. 

Style  A general term related to the overall 
appearance of the text in a document.  

Program/Application 

A software program that allows 
you to do different things on the 

computer.  
File/Document A computer file is 

created using an 
applications program, 

for example, a database, 
spreadsheet, illustration, or text file. 

Scanner 

A device that "takes a 
picture" of something and turns it into 

a computerized image. 
Digital Format 

Processing, operating on, 
storing, transmitting, representing, or 

displaying data in the form of 
numerical digits, as in a digital 
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computer. 
Spreadsheet A spreadsheet is a 

document that helps you 
organize data in rows 
and columns of cells.  

 
Hyperlink Hyperlinks are the easy-to-spot 

underlined words or phrases you click 
in World Wide Web documents to 

jump to another screen or page. 
Database A database is an organized collection 

of information.  It is like a box of 3x5 
cards that you can search, sort and 

analyze rapidly with a database 
program. 

Search Engine  

A tool or program that 
allows keyword searching for relevant 
sites or information on the Internet. 
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*Shading indicates new skills for this grade level. 

 
Elementary Technology Applications TEKS 

Literacy Guide 
Grade Four 

 

Vocabulary:  Learn grade level appropriate technology 
terminology. 1A 
   
New:    
Title bar Input  Output 
Graphic Presentation  Multimedia  
File extension  Netiquette Field  
Modem  Virus  Searching  
Download Navigate   
   
Review:   
Format Style Program/application 
File/document Scanner Digital format 
Taskbar Hyperlink Search engine 
Spreadsheet Database  
   
   
   

 

Skills/Foundations: 
 
Use My Computer to navigate to available drives. 2C 
Open and close programs using method of choice. 1B 
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Use mouse to perform single-click, double-click, and click and drag functions 
with the left and right mouse buttons.  2A 
Use the mouse to scroll up or down within a window by clicking and dragging the 
scroll bar or clicking the up or down arrows. 2A 
Minimize, maximize, and restore windows as needed. 2A 
Open CD-ROM tray, insert CD, close CD-ROM tray, and access files/programs on 
CD. 2A 
Understand and properly use Save and Save As appropriately. Save As- Allows 
the destination, file name, and file type to be chosen.  Save- Saves files using 
existing location, file name, and file type.  1B 
Use the Undo feature in Microsoft Office applications to recover previous work 
(i.e.  recover typed words, unpaste, unformat, etc.). 2D 
Take pictures using a digital camera and upload them to a computer or network 
folder. 2A, 1E 
Print documents. 1E 
Use the scanner to digitize images and use them within an application.  2A, 7C 
Use the laptops within the wireless lab (COWS) applying skills learned to use the 
touchpad as a mouse.  2A 
Navigate through appropriate programs. 2A 
Use Copy, Cut, and Paste functions to edit documents. 2D, 7B, 7C 
Use the Help menu to type in a keyword and/or look at the available list of 
topics. 9A 
Use the Print Preview, Slideshow/View Show, and Slide Sorter View 
features available in programs to view files for proper format prior to printing. 9B 
Use two or more software applications at the same time by tiling the windows 
vertically or horizontally.  1B 
Use the Ctrl+Alt+Delete keys to unfreeze the computer. 1B 
Right–click on files, folders, icons, and within applications to access menu 
options. 2A 
Delete files within personal network folder by right-clicking the file icon and 
choosing delete. 2A 

 

Networking: 

 
Log on to the BISD network using personal username by the end of the first six 
weeks. 1E 
Log off network. 1E 
Create, name, and save files to personal directory on the network. 1B 
Access files from network folders. 1D, 1E 
Print to a networked printer using the printer icon or selecting Print from the 
File menu. 1E 
Select and print to the appropriate networked printer. 1E 
Save and Copy files from the network folder by copying (by clicking and dragging 
the icon) or using the Save As feature within the program.  1B 
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Acceptable Use: 

 
Knows not to use other’s work. 3B 
Knows it is inappropriate to access another individual’s file. 3B 
Knows it is not appropriate to copy/load software for which you do not have a 
license.  3B 
Student will demonstrate an understanding of the rules when accessing BISD 
computers.   3A 
Teachers will reinforce the rules included in the BISD Acceptable Use Policy and 
model appropriate use of the computer.  3A 

 
 

 
 
 

Problem Solving: 

 
Use software to express ideas and solve problems.   
This can include, but is not limited to text, graphics, charts, and visual organizers, 
multimedia, and spreadsheets. 7A, 7B, 7C, 10C 
Use communication tools to acquire and share information and solve problems 
(e.g. distance learning, discussion groups, Blogs, email). 8A, 8B, 8C 

 

Software Applications: 
 
Word Processing (Microsoft Word): 
 
Create a new document or open an existing one on the network folder. 2D, 2E 
Enter text. 2C, 2D 
Change font size, type, style (bold, italicize, underline), and color of font. 10A, 
10B 
Use Alignment tools to format text (left, right, center, justify). 10A, 10B 
Format text by using Bullets and Numbering. 10A, 10B 

Information Acquisition: 

 
Acquire information that is in the form of text, graphics, audio, and video and 
save information for use in student projects consistent with copyright issues, with 
teacher assistance, as needed.  5A, 4A, 4B 
Analyze the content (“Is it what I need?”) and validate the quality (“Is the 
information accurate?”) of information obtained from the Internet.  6A, 6B, 6C 
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Use the Spelling and Grammar and Thesaurus features to edit documents.  
2D, 9A 
Understand AutoCorrect feature for spelling and grammar (Red underline-
misspelling, green underline-grammar).  Correct these by right-clicking on the 
underlined word(s) and selecting the appropriate option.  2D, 9A 
Use the Backspace and Delete key to delete text. 2D 
Use the Shift key to make capital letters and access punctuation marks. 2C, 2D 
Insert pictures from Clipart Gallery and from File (e.g. My Pictures, network 
folder, digital camera, scanner, or other source). 2A, 10A 
Move and resize clipart and or images by right-clicking on the image, selecting 
Format Picture, clicking the Layout tab, and choosing the appropriate Wrapping 
Style or using the Picture Toolbar.  7A, 10A 
Adjust margins, page orientation, and vertical alignment using Page Setup 
under the File menu. 2D 
Insert Headers and Footers using the View menu. 2D 
 
Multimedia (PowerPoint): 
 
Create a new presentation or open an existing presentation on the network folder. 
7A, 7B, 1E 
Use a teacher-created template to complete an activity.  7A, 7B 
Add text to slides.  11A, 11B 
Insert multiple New Slides. 7A, 7B 
Change font size, type, style (bold, italicize, underline), and color. 10A, 10B 
Use Alignment tools to format text (left, right, center, justify).  10A, 10B 
Format text by using Bullets and Numbering. 10A, 10B 
Use the Spelling and Grammar and Thesaurus features to edit documents.  
2D, 9A 
Insert pictures from Clipart Gallery and from File (digital camera, scanner, or 
other source). 2A, 10A 
Change backgrounds by selecting Format from the menu bar and choosing 
Background. 10A, 10B 
Use the Slide Sorter view to organize (change sequence) and edit presentation. 
9A, 9B 
Remove individual slides in the Slide Sorter view by right-clicking and choosing 
Delete.  2A, 9B 
 
Spreadsheet (Excel): 
 
Open and existing spreadsheet on the network folder. 1E, 10C 
Enter data in an existing template to complete an activity (e.g. have a spreadsheet 
set up so that students can enter data into the spreadsheet and a graph/chart will 
automatically be created with the results). 7B, 7C 
Identify and locate cells, rows, and columns. 7B, 7C 
Create a spreadsheet by entering text, and values (numeric) and simple formulas. 
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7B 10C   
Use Chart Wizard to create charts/graphs as grade level and task appropriate to 
express ideas and solve problems. 7B, 10C 
Format cells by changing column width and row height.  10A, 10B 
Change the font size, type, style (bold, italicize, underline), and color.  10A, 
10B 
Use the Spelling and Grammar feature to edit spreadsheets. 2D, 9A 
 
Desktop Publishing (Publisher): 
 
Use a teacher-created template to complete an activity.  1E, 7A, 7C 
Select a document type and use the Publisher Wizard to choose a design, color 
scheme, and layout. 7B, 9A, 10A 
Click in the text boxes and replace text.  2D 
Use the Spelling Check features to edit documents.  9A 
Insert pictures from Clipart Gallery and from File (digital camera, scanner, or 
other source). 2A, 10A 
Right-click on images, choose Change Picture, Picture, and Clipart to replace 
existing picture with another selection. 10A 
 
Paint (KidPix): 
 
Use skills mastered at previous grade levels to complete products that are task 
appropriate, express ideas, and solve problems. 7A 
 
 
Graphic Organizer (Kidspiration/Inspiration): 
 
Open a Kidspiration/Inspiration template or a teacher-created template to 
complete an activity. 7A, 11A 
Insert symbols or pictures into a diagram. 7C 
Insert text. 7C 
Change the font size, type, style (bold, italicize, underline), and color. 10A, 
10B 
Use the link tool to connect objects within a diagram. 7A 
Compile notes and ideas into outlines using the outline view and diagram view 
(Inspiration). 7A, 7C 
Use the Spell Check icon to edit diagrams.  9A 
Use the Rapid Fire tool (Inspiration) to input ideas into a diagram. 7A, 7B, 7C 
Transfer completed diagram to Microsoft Word (Inspiration).  7A, 7C 
 
Internet Browser (Internet Explorer): 
 
Click on a link to view a web site. 5A 
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Use the Back, Forward, and Home buttons to navigate.  5A, 5B 
Conduct simple keyword searches using a grade-level appropriate/kid friendly 
search engines, such as Yahooligans. 4A, 4B, 5A 
Gather information from websites found from search results.  5A, 5B 
Evaluate the effectiveness of search strategies.  6A, 6B 
Determine whether web sites provide useful and appropriate information. 6C 
Use the acquired information in the creation of products. 11A 
Use the web to tour virtual environments, remote locations, and/or explore on 
line interactive lessons. 8B 
Recognize and identify sources of URL suffixes including, but not limited to, .org 
.com, .edu, .gov, and .net. 6A 

 
 
 

Communication: 

 
Display work for a variety of audiences in a variety of forms (print, monitor, 
projector, and video).  10B 
Use desktop publishing techniques to create effective documents and presentations 
(make good choices with regard to font, white space, and contrast for readability). 
10A  
Proofread products and make improvements. 2D, 2E 
Create charts/graphs using spreadsheets /databases and extract information from 
them.  10C 
Use tools such as checklists, timelines, and rubrics to evaluate products and 
determine relevancy to task and specific lesson objectives. 12B 
Select representative products to be collected and stored in an electronic portfolio 
with teacher assistance. 12A 
Evaluate products created for relevance to the assignment or task.  12A 
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4th Grade Technology Terminology 
 

Title Bar 
The top portion of a 

computer window that gives the name of the 
application and the file name or the name of the 

Internet Web site being displayed. 
Input To enter data or a program into a 

computer. 

Output The information produced by a program or 
process from a specific input. 

Graphic 

A graphic display generated by a 
computer or an imaging device. 

Presentation 

A show or display; the act of 
presenting something to sight or view; a visual 

representation of something. 
Multimedia 

Of or relating to an application that can 
combine text, graphics, full-motion video, and 

sound into an integrated package. 
File Extension The portion of a filename (a period followed by 

one to three letters) which indicates the kind of 
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data stored in the 
file. 

Netiquette 

Etiquette practiced or 
advocated in electronic communication over a 

computer network. 
Field A defined area such as adjacent columns on 

spreadsheet, used to record a type of information 
consistently. 

Modem 

Electronic equipment consisting 
of a device used to connect computers by a 

telephone line. 
 This device transmits digital data over telephone 
wires by converting the data into an audio signal 

to send it, and converting an audio signal into 
data to receive it.   

Virus 

A software program capable of 
reproducing itself and usually capable of causing 
great harm to files or other programs on the same 

computer. 
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Searching 

 By using a search tool or 
search engine, you search a database, files, or a 

collection of sites of the entire World Wide Web. 
A search engine tool, such as Google, provides 

you with links to other pages. You click on these 
links to retrieve documents, images, sound, and 
more from individual servers around the world. 

Download 

To transfer a file or program from a central 
computer to a smaller computer or to a computer 

at a remote location. 
Navigate 

The act of moving through a 
webpage, website, or the World Wide Web. 
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*Shading indicates new skills for this grade level. 

 
Elementary Technology Applications TEKS 

Literacy Guide 
Grade Five 

 

Vocabulary:  Learn grade level appropriate technology 
terminology. 1A 

 
New:    
Byte Kilobyte Megabyte 
Gigabyte LAN WAN 
Peripherals Operating system Ethernet cable 
Html Simulations  
   
Review:   
Title bar Input  Output 
Graphic Presentation  Multimedia  
File extension  Netiquette Field  
Modem  Virus  Searching  
Download Navigate  
   
   

 

Skills/Foundations: 

 
Use My Computer to navigate to available drives. 2C 
Open and close programs using method of choice. 1B 
Use mouse to perform single-click, double-click, and click and drag functions 
with the left and rights mouse buttons. 2A 
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Use the mouse to scroll up or down within a window by clicking and dragging the 
scroll bar or clicking the up or down arrows. 2A 
Minimize, maximize, and restore windows as needed. 2A 
Open CD-ROM tray, insert CD, close CD-ROM tray, and access files/programs on 
CD. 2A 
Understand and properly use Save and Save As appropriately. Save As- Allows 
the destination, file name, and file type to be chosen.  Save- Saves files using 
existing location, file name, and file type. 1B 
Use the Undo feature in Microsoft Office applications to recover previous work 
(i.e.  recover typed words, unpaste, unformat, etc.). 2D 
Take pictures using the digital camera and upload them to a computer or network 
folder.  2A, 1E 
Print documents. 1E 
Use the scanner to digitize images and use them within an application. 2A, 7C 
Use the laptops within the wireless lab (COWS) applying skills learned to use the 
touchpad as a mouse.  2A 
Navigate through appropriate programs. 2A 
Use Copy, Cut, and Paste functions to edit documents. 2D, 7B, 7C 
Use the Help menu to type in a keyword and/or look at the available list of 
topics. 9A 
Use the Print Preview, Slideshow/View Show, and Slide Sorter View 
feature available in most programs to view files for proper format prior to 
printing. 9B  
Use two or more software applications at the same time by tiling the windows 
vertically or horizontally.  1B 
Use the Ctrl+Alt+Delete keys to unfreeze the computer. 1B 
Right–click on files, folders, icons, and within applications to access menu 
options. 2A 
Delete files within personal network folder by right-clicking the file icon and 
choosing Delete. 2A 
 

Networking: 

 
Log on to the BISD network using personal username by the end of the first six 
weeks.  1E 
Log off network. 1E 
Create, name, and save files to personal directory on the network. 1B 
Access files from the network folders. 1D, 1E 
Rename files and folders with personal directory by right-clicking and choosing 
Rename. 1B 
Adjust the View of files and folders within personal directory by selecting View 
from the menu bar and choosing Large Icon, Small Icon, List, or Details. 1B 
Organize files and folders within a personal directory by selecting View from the 
menu bar, choosing Arrange Icons and making a selection. 1B 
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Print to a networked printer using the printer icon or selecting Print from the 
File menu. 1E 
Select and print to the appropriate networked printer. 1E 
Save and copy files from the network folder by copying (by clicking and dragging 
the icon) or using the Save As feature within the program. 1B 

 

Acceptable Use: 

 
Knows not to use other’s work. 3B 
Knows it is inappropriate to access another individual’s file. 3B 
Knows it is not appropriate to copy/load software for which you do not have a 
license.  3B 
Student will demonstrate an understanding of the rules when accessing BISD 
computers.  3A 
Teachers will reinforce the rules included in the BISD Acceptable Use Policy and 
model appropriate use of the computer.  3A 

 
 

 
 
 
 

Problem Solving: 

 
Use software to express ideas and solve problems.   
This can include, but is not limited to text, graphics, charts, and visual organizers, 
and spreadsheets. 7A, 7B, 7C, 10C 
Use preview options to evaluate the results of work before final product is 
presented. 9A 
Use communication tools to acquire and share information and solve problems 
(e.g. distance learning, discussion groups, Blogs, email, and web pages). 8A, 8B, 
8C, 11A  

 

Software Applications: 

Information Acquisition: 

 
Acquire information that is in the form of text, graphics, audio, and video and 
save information for use in student projects consistent with copyright issues, with 
teacher assistance, as needed.  5A, 4A, 4B 
Analyze the content (“Is it what I need?”) and validate the quality (“Is the 
information accurate?”) of information obtained from the Internet. 6A, 6B, 6C 
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Word Processing (Microsoft Word): 
 
Create a new document or open an existing one on the network folder. 2D, 2E 
Enter text. 2C, 2D 
Change font size, type, style (bold, italicize, underline), and color of font. 
10A, 10B 
Use Alignment tools to format text (left, right, center, justify). 10A, 10B 
Format text by using Bullets and Numbering. 10A, 10B 
Use the Spelling and Grammar and Thesaurus features to edit documents. 
2D, 9A 
Understand AutoCorrect feature for spelling and grammar (Red underline-
misspelling, green underline-grammar).  Correct these by right-clicking on the 
underlined word(s) and selecting the appropriate option.  2D, 9A 
Use the Backspace and Delete keys to delete text. 2D 
Use the Shift key to make capital letters and access punctuation marks. 2C, 2D 
Insert pictures from Clipart Gallery and from File (e.g. My Pictures, digital 
camera, scanner, or other source). 2A, 10A 
Move and resize clipart and/or images by right clicking on the image, selecting 
Format Picture, clicking the Layout tab, and choosing the appropriate 
Wrapping Style, or using the Picture Toolbar. 7A, 10A 
Adjust margins, page orientation, and vertical alignment using Page Setup 
under the File menu. 2D 
Insert Headers and Footers using the View menu. 2D 
Create a table to structure and organize information. 10C 
Access available toolbars (Standard, Formatting, Drawing, etc.) by selecting 
View from the menu bar and choosing Toolbars. 1B 
Use Draw tools (WordArt, Text Box, Paint Bucket, Lines and Arrows, 
and Autoshapes). 10A, 10B 
Set Columns. 10A, 10B, 10C 
Set Page/Section Breaks. 10A, 10B 
 
Multimedia (PowerPoint): 
 
Create a new presentation or open an existing presentation on the network 
folder.  7A, 7B, 1E 
Use a teacher-created template to complete an activity. 7A, 7B 
Insert multiple New Slides. 7A, 7B 
Add text to slides.  11A, 11B 
Change font size, type, style (bold, italicize, underline), and color. 10A, 10B 
Use Alignment tools to format text (left, right, center, justify). 10A, 10B 
Format text by using Bullets and Numbering. 10A, 10B 
Use the Spelling and Grammar and Thesaurus features to edit documents. 
2D, 9A  
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Insert pictures from Clipart Gallery and from File (e.g. My Pictures, digital 
camera, scanner, or other source). 2A, 10A, 1C 
Change backgrounds by selecting Format from the menu bar and choosing 
Background. 10, 10B 
Use the Slide Sorter view to organize (change sequence) and edit presentation. 
9A, 9B 
Remove individual slides in the Slide Sorter view by right-clicking and 
choosing Delete. 2A, 9B 
Use Design Templates to customize presentations. 10A, 10B 
Add and remove text boxes. 10A, 10B 
Access available toolbars (Standard, Formatting, Drawing, etc.) by selecting 
View from the menu bar and choosing Toolbars. 1B 
Use Draw tools (WordArt, Text Box, Paint Bucket, Lines and Arrows, 
and Autoshapes). 10A, 10B 
Edit Slide Transitions and Custom Animation to enhance presentations. 
11A, 11B 
Insert sound file or record voice into presentation. 11A, 7B, 7C 
Insert video taken with digital camera, video camera, or other source. 7C 
 
Spreadsheet (Excel): 
 
Open and existing spreadsheet on the network folder. 1E, 10C 
Enter data in an existing template to complete an activity (e.g. have a spreadsheet 
set up so that students can enter data into the spreadsheet and a graph/chart will 
chart the results). 7B, 7C 
Identify and locate cells, rows, and columns. 7B, 7C 
Create a spreadsheet by entering text, and values (numeric) and simple formulas. 
7B, 10C  
Use Chart Wizard to create charts/graphs as grade level and task appropriate 
to express ideas and solve problems. 7B, 10C 
Format cells by changing column width and row height. 10A, 10B 
Change the font size, type, style (bold, italicize, underline), and color. 10A, 
10B 
Use the Spelling and Grammar feature to edit spreadsheets. 2D, 9A 
Insert and delete columns and rows. 1B 
Access available toolbars (Standard, Formatting, Drawing, etc.) by selecting 
View from the menu bar and choosing Toolbars. 1B 
Use Draw tools (WordArt, Text Box, Paint Bucket, Lines and Arrows, 
and Autoshapes). 10A, 10B 
Right-click on cells, columns, or rows and select Format Cells to change 
Number, Alignment, Font, Border, Patterns, or Protection. 10 
A, 10B 
Select a range of cells. 2A 
Sort records in alphabetical or numerical order. 10C 
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Desktop Publishing (Publisher) 
 
Use a teacher-created template to complete an activity. 1E, 7A, 7C 
Select a document type and use the Publisher Wizard to choose a design, color 
scheme, and layout. 7B, 9A, 10A 
Click in the text boxes and replace text. 2D 
Use the Spelling Check features to edit documents. 9A 
Right-click on images, choose Change Picture, Picture, and Clipart to 
replace existing picture with another selection. 10A 
Insert pictures from Clipart and from File (e.g. My Pictures, digital camera, 
scanner, and other source). 2A, 10A 
Access available toolbars (Standard, Formatting, Drawing, etc.) by selecting 
View from the menu bar and choosing Toolbars. 1B 
Use Draw tools to add Text Boxes, Lines, WordArt,  AutoShapes, etc. 10A, 
10B 
Delete Object(s) (text boxes, clipart, etc.) by right-clicking and selecting this 
option. 1B 
Create a webpage using Publisher Webpage Wizard. 10B, 11A, 1D 
 
Paint (KidPix): 
 
Use skills mastered at previous grade levels to complete products that are task 
appropriate, express ideas, and solve problems, as needed. 7A  
 
 
Graphic Organizer (Kidspiration/Inspiration): 
 
Open a Kidspiration/Inspiration template or a teacher-created template to 
complete an activity. 7A, 11A 
Insert symbols or pictures into a diagram.  7C 
Insert text. 7C 
Change the font size, type, style (bold, italicize, underline), and color. 10A, 
10B 
Use the link tool to connect objects within a diagram. 7A 
Compile notes and ideas into outlines using the outline view and diagram view 
(Inspiration). 7A, 7C 
Use the Spell Check icon to edit diagrams. 9A 
Use the Rapid Fire tool (Inspiration) to input ideas into a diagram. 7A, 7B, 7C 
Create hyperlinks (Inspiration). 7B, 10B 
Transfer completed diagram to Microsoft Word (Inspiration).  7A, 7C 
 
Internet Browser (Internet Explorer): 
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Click on a link to view a web site. 5A 
Use the Back, Forward, and Home buttons to navigate. 5A. 5B 
Conduct simple keyword searches using a grade-level appropriate and/or kid 
friendly search engines.  4A, 4B, 5A 
Gather information from websites found while applying electronic search 
strategies (e.g. keyword searches). 5A, 5B, 4A 
Evaluate the effectiveness of search strategies. 6A, 6B 
Determine whether web sites provide useful and appropriate information. 6C 
Use the acquired information in the creation of products. 11A 
Use the web to tour virtual environments, remote locations, and/or explore on 
line interactive lessons. 8B 
Recognize and identify sources of URL suffixes including, but not limited to, .org, 
.com, .edu, .gov, and .net. 6A 
Use Bookmark or Favorites feature to identify and save sites to an individual 
computer. 1B 
 

 
 
 

Communication: 

 
Display work for a variety of audiences in a variety of forms (print, monitor, 
projector, video, Internet).  10B 
Use desktop publishing techniques to create effective documents and 
presentations (make good choices with regard to font, white space, and contrast 
for readability).  10A 
Proofread products and make improvements. 2D, 2E 
Create charts/graphs using spreadsheets /databases and extract information from 
them. 10C 
Use tools such as checklists, timelines, and rubrics to evaluate products and 
determine relevancy to task and specific lesson objectives. 12B 
Select representative products to be collected and stored in an electronic portfolio 
with teacher assistance. 12A 
Evaluate products created for relevance to the assignment or task.  12A 
Help create technology project assessment tools to monitor progress of a project 
(e.g. checklist, timeline, rubric). 12C 
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5th Grade Technology Terminology 
 

Byte 

Eight bits of information; eight 
individual consecutive electronic on/off 

signals which make a message that a 
computer can interpret. 

Kilobyte 

One thousand bytes. 
Megabyte 

One million 
bytes. 

Gigabyte Approximately 111,,,000000000   mmmeeegggaaabbbyyyttteeesss (1,024 
megabytes). 

LAN 

(Local Area Network) A 
computer network limited to the 

immediate area, usually the same building 
or floor of a building. 

WAN 

(Wide Area Network) In 
data communications, a comprehensive 

multimode network connecting large 
numbers of computers spread over a wide 

area. 
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Peripherals 

Any external device that plugs 
into your computer such as a printer, 

modem, scanner, and digital/video 
cameras. 

Operating 
System 

A program that is a basic set of 
instructions that allows a computer to 

perform its basic functions. 
Ethernet Cable 

An Ethernet cable should 
be plugged into the LAN (Local Area 
Network) Connector Port on the back of 
the computer and into the LAN network 
‘drop’ (port) in the wall. 

 
HTML 

(Hypertext Markup 
Language) A language used to create 

hypertext documents for the World Wide 
Web. 
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Simulations 

Simulations allow 
students to experience a real life situation 

in an artificial environment. 
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Student and Parent Agreement for the 
Acceptable Use of the 

District’s Electronic Communications 
System 

 
Students may be given access to the District's electronic communications system 
for educational purposes.  
 
The electronic communications system is defined as the District’s 
network, servers, computer workstations, peripherals, applications, 
databases, online resources, Internet access, email, and any other 
technology designated for use by students.  
 
With this educational opportunity comes responsibility. It is important that 
students read (or have read to them age-appropriate sections) and parents read 
the Birdville ISD Administrative Regulation for Acceptable Use and then ask any 
questions if needed. Inappropriate system use of the District’s electronic 
communications system use will result in the consequences below, including loss 
of the privilege to use this educational tool. 
 
Please note that Internet access is part of the District’s electronic 
communications systems. The Internet is a network of many types of 
communication and information networks. It is possible that students may run 
across areas of adult content or material students (or their parents) might find 
objectionable. While the District uses filtering technology and protection 
measures to restrict access to such material, it is not possible to absolutely 
prevent such access. 
 
It will be each student’s responsibility to follow the rules for 

appropriate and acceptable use. 
 
SOME RULES FOR APPROPRIATE USE 
• Students must only open, view, modify, and delete their own computer files, 
unless they have specific permission from a teacher or staff member to do 
otherwise. 
• Internet use at school must be directly related to school assignments and 
projects. 
• Students may be assigned an individual account and must use only those 
accounts and passwords that they have been granted permission by the District to 
use. All account activity should be for educational purposes only. 
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• Students are responsible at all times for their use of the District’s electronic 
communications system and must assume personal responsibility to behave 
ethically and responsibly, even when technology provides them the freedom to do 
otherwise. 
 
 
INAPPROPRIATE USES 
• Using the District’s electronic communications system for illegal purposes. 
• Disabling or attempting to disable any system monitoring or filtering or security 
measures. 
• Sharing your user name and password with others, borrowing someone else’s 
user name, password, or account access. 
 
• Purposefully opening, viewing, using, or deleting files belonging to another 
system user without permission. 
• Electronically posting personal information about yourself or others (i.e., 
addresses, phone numbers, and pictures). 
• Downloading or plagiarizing copyrighted information without permission from 
the copyright holder. 
• Intentionally introducing a virus or other malicious programs onto the District’s 
system. 
• Electronically posting messages or accessing materials that are abusive, 
obscene, sexually oriented, threatening, harassing, damaging to another's 
reputation, or illegal. 
• Wasting or abusing school resources through unauthorized system use. 
• Gaining unauthorized access to restricted information or network resources. 
 
 
CONSEQUENCES FOR INAPPROPRIATE USE 
• Suspension of access to the District’s electronic communications system; 
• Revocation of the District’s electronic communications system account(s); 
and/or 
• Other appropriate disciplinary or legal action in accordance with the Student 
Code of Conduct. 

 


